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BATHYMETRIC MODELING - THE PREMISE FOR 

CREATING FLOW AND SEDIMENT TRANSPORT 

MODELS 

1. INTRODUCTION 

 

In the field of Hydrotechnics, modeling is an extremely effective tool for solving 

concrete problems by reproducing the phenomena studied with the help of hydraulic models. 

In general, by “model” we mean the set of objects, including symbols or simplified 

representations, which are in a correspondence relationship with the phenomenon subject to 

knowledge [1]. 

A successful model is more accessible for research than the real object and allows new 

information about it to be obtained. The process of building the model is called modeling. 

Hydraulics, like other natural sciences, uses theoretical methods and experimental 

methods in investigations. 

Hydraulic modeling has developed as a scientific research method since the twentieth 

century, when the foundations of dimensional analysis (instrument of the theoretical method) 

and similarity theory (theoretical basis of hydraulic modeling) were laid. 

In nature, there are very complex physical phenomena whose mechanism is not yet 

sufficiently well studied, which leads to the impossibility of establishing the general equations 

of the phenomenon and formulating the appropriate conditions of uniqueness. In these 

situations, general research methods are applied, which are less accurate, but which allow the 

determination of the general form of the laws of these physical phenomena. Thus, if we know 

the physical quantities 𝐴1, 𝐴2, ..., 𝐴𝑛, which intervene in the development of a phenomenon, 

and we assume the existence of only one unknown function among them f (𝐴1, 𝐴2, ..., 𝐴𝑛), then 

some links between these quantities can be established using their dimensional nature [2]. In 

addition, it must be borne in mind that physical relations represent relations between physical 

(dimensional) quantities, while mathematical relations operate with abstract numbers. This 

mode of research is known in science as dimensional analysis and is used when, on an 

experimental basis, the hydraulic parameters of the studied phenomenon can be known. 

Regarding the theory of hydraulic similarity1, its statement offered the possibility that 

complex phenomena in nature can be studied on small scale models, and the results obtained 

can be extended, according to certain laws, to a whole class of such phenomena. 

The similarity can be geometric, kinematic or dynamic, depending on the 

proportionality of the determining quantities. 

 The Geometric Similarity is the simplest form of similarity. There is a geometric 

similarity between the phenomenon on the model (M) and the phenomenon on the 

prototype (N) if the proportionality of the homologous lengths and the equality of the 

angles are ensured. One point on the model corresponds to a single point on the 

                                                           
1 Two phenomena, M (model) and N (nature) are similar if they belong to the same class and if there are 

proportional relations between the homologous quantities with which these phenomena are described [17]. 



   Research report no. 2  

  Bathymetric Modeling - The Premise for Creating Flow and Sediment Transport Models 

6 
 

prototype (the real object) and vice versa, the two points arranged identically on the 

model and prototype being called homologous points. These homologous points can 

determine homologous lines, homologous surfaces, and homologous volumes. 

Therefore, the geometric similarity presupposes a unique scale for lengths (S1): 

𝑆𝑙 =
𝑙𝑀

𝑙𝑁
 ;                                                          (1-1) 

Geometric similarity can be ensured by making the scale model, geometrically 

undistorted. The geometric scale is also known as the modeling scale. 

 The kinematic similarity represents the similarity of movement and implies, in 

homologous points, the geometric similarity of the Hydrodynamic field (the aspect of 

the flow is the same on the model and prototype) and the constant ratio of the kinematic 

quantities of the same type (speeds, accelerations). Once the length scale is established, 

there is a constant ratio of the time in which the phenomenon takes place on the 

prototype and the time in which the phenomenon takes place on the model, that is the 

time scale (St): 

𝑆𝑡 =
𝑡𝑀

𝑡𝑁
 ;                                                         (1-2) 

 The dynamic similarity requires that the ratio of all the forces in nature, on the prototype 

and on the model, be constant. The result is the force scale (Sf): 

 𝑆𝑓 =
𝑓𝑀

𝑓𝑁
 ;                                                         (1-3) 

However, the realization of these conditions on a hydraulic model is not entirely 

possible, due to the variety of forces that determine the movement of the fluid, which attracts a 

series of conditions that are difficult to meet regarding the physical constants of the fluids. In 

the practice of hydraulic modeling, the dominant forces of the modeling phenomenon are first 

considered and then the condition of dynamic similarity is imposed only on these forces. In this 

way different models ("similarity criteria") are obtained according to the category of forces 

taken into consideration. These criteria can be expressed by dimensionless quantities called 

characteristic numbers. 

In other words, if a concrete physical phenomenon is described by several physical 

quantities of the same nature (with the same dimensions), any ratio of two of these quantities 

represents a dimensionless complex, which is usually denoted by the letter π, accompanied by 

an index. Dimensional complexes can also be seen as numbers, because they result from the 

ratio of two quantities of the same dimensions. 

Considering some of the determinant physical quantities in the description of the 

phenomena within fluid mechanics, namely: characteristic length l, fluid velocity u, fluid 

density ρ, dynamic coefficient of fluid viscosity μ, pressure p, gravitational acceleration g, 

sound velocity a and coefficient of surface tension σ, the following criteria can be formed using 

these quantities [3]: 

 The Reynolds Criterion - is the basic condition for the model in which the viscosity 

forces are dominant: 

        𝑅𝑒 =
𝑢𝑙𝜌

𝜇
 = 

𝑢𝑙

𝑣
 ;      (1-4) 
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 The Euler Criterion - used when, in addition to inertial forces, pressure forces must 

also be taken into account: 

𝐸𝑢 =
𝑝

𝜌𝑢2 ;       (1-5) 

 The Froude Criterion - used to model movements in which the force of gravity is 

predominant: 

    𝐹𝑟 =
𝑢2

𝑔𝑙
 ;                                                        (1-6) 

 The Mach Criterion - intervenes in the modeling of movements that take into account 

the compressibility of the fluid:  

  𝑀𝑎 =
𝑢

𝑎
 ;                                 (1-7) 

 The Weber Criterion - is used to model those movements in which, in addition to the 

inertial forces, the surface tension force is predominant: 

  𝑊𝑒 =
𝜌𝑢2𝑙

𝜎
 ;                             (1-8) 

 When the movement is non-permanent, the Strouhal Criterion is introduced: 

  𝑆ℎ =
𝑙

𝑢𝑡
 ;                             (1-9)) 

where t represents the characteristic time. 

The theory of hydraulic similarity demonstrates that not all criteria can be applied 

simultaneously, the best known incompatibility being Re and Fr. Solving such situations is done 

by developing models with hydraulic distortion, that is one of the two incompatible criteria 

is abandoned.  

Hydraulic or hydrodynamic modeling operates with two types of models: physical 

models and numerical models [4]. 

Physical models are distinguished by the particularity of reproducing the studied 

phenomena studied on a scale other than the natural one. In the case of hydraulic phenomena, 

which occur in large spaces, physical models are made on a small scale [5]. 

In recent decades, due to the development of automatic computing hardware, as well as 

mathematical methods for integrating differential equations, numerical or mathematical models 

have experienced rapid development. They are applied in various branches of hydraulics, such 

as one-dimensional and two-dimensional free flows, pressure flows, underground flows, etc. 

These models represent sets of mathematical relationships between parameters that describe a 

certain physical phenomenon. 

Mathematical models can be built in two fundamentally different ways, the two types 

being known as deterministic models and stochastic models, which reflect the methods of 

classical physics and statistical physics for the discovery and study of the laws governing 

natural phenomena. 

Deterministic models refer to the phenomena described by a relatively small number 

of parameters. Laws that express the connection between parameters that describe one or more 

phenomena take the form of equations called the equations of mathematical physics. 

Stochastic models are based on mathematical statistics. By analyzing a large number 

of events, statistics can discover the laws that govern them, regardless of how they are 

determined (without following the cause-effect relationship), through correlations. 
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A current trend is the complementary use of physical and numerical models, as the 

physical model provides the data needed to calibrate the numerical model. 

 

2. THE PRINCIPLES OF HYDRAULIC MODELING  

 

A fundamental problem of Hydraulics is the free surface movement of water in rivers 

and canals (or in pipes with a partially full section).  

Free surface (or free level) movements are the movements of liquids that occur so that 

along the current there is a free surface in contact with the atmosphere [6].  

Depending on the variation in time and space of the hydraulic parameters (flow, speed, 

depth, slope, surface and wetted perimeter), the free-surface flow in riverbeds can be classified 

according to Figure 1 as follows [7]: 

 
Figure 1. Classification of free-surface flow types 

 

The type of flow is directly influenced by the changes suffered by the riverbed. 

In general, the flow in the open riverbeds has a non-permanent and non-uniform 

character, due to the way the watercourses are fed, but also due to the frequent non-uniformities 

in the riverbed. 

However, in the event that the variation of flows and levels is slow, for short periods of 

time, the flow can be considered permanent (uniform or non-uniform)2. 

Non-permanent free-surface flows are undulating in nature and arise as a result of 

changes in boundary conditions, by changing flows or levels. These disturbances, which are 

transmitted with finite speed in the form of waves, simultaneously change both the flow and 

the level. Since the transmission of level changes leads to a change in the shape of the free 

surface, any non-permanent motion with the free surface can be recognized by the variation of 

the shape of the free surface over time, as is the case, for example, with waves. 

Being a non-linear phenomenon, with different forms of manifestation, the calculation 

of non-permanent movements with free surface is very complicated. 

                                                           
2 The types of permanent movement (uniform, gradually varied non-uniform and rapidly varied non-uniform) were 

presented in Report no. 2 - Hydrology and river hydraulics. 
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In the case of non-permanent movements in rivers and canals, in addition to the 

undulating phenomenon of propagation of disturbances, there is also the phenomenon of 

transport, movement of water at a certain speed. 

The mathematical modeling of the riverbed consists in the simulation of the flow 

conditions, based on the formulation and solution of the mathematical relations that express the 

equations of motion of the water in the riverbed. 

In non-permanent motion, the speed of water also has components in the plane of the 

cross section of the riverbed [8], and for the mathematical modeling of non-permanent motion, 

it is necessary to resort to simplified schematics that include only aspects with essential 

influence on real processes and often, to ignore those of secondary importance. 

After establishing the equations that shape the physical process in its main aspects, their 

mathematical or numerical treatment, executed correctly, does not change the physical nature 

of the analyzed process. 

In most cases, a one-dimensional schematization is performed, so that the non-

permanent flow in the riverbeds is described by the evolution over time, in any cross section, 

of two dependent variables, namely: the stage of the free-surface area of water y (or water depth 

h ) and discharge Q (or average speed in section v). These dependent variables define the state 

of motion in relation to two independent variables: the spatial position along the riverbed x 

(relative to a conveniently chosen origin) and the time t (relative to the moment of occurrence 

of the disturbance). 

The dependent and independent variables that appear in the non-permanent flow in the 

riverbeds are linked to each other by two equations that come from the laws of conservation of 

mass, momentum and mechanical energy. 

The hypotheses underlying the one-dimensional model, together with the equations 

describing non-permanent one-dimensional motion were formulated by Barré de Saint-Venant 

in 1871 at the French Academy in his paper "Théorie et equations generales du mouvement 

non-permanent des eaux courantes" 

In the literature, the fundamental equations of non-permanent motion in open riverbeds 

are called the Saint-Venant equations. Several forms of the Saint-Venant equations can be 

used to analyze the movement of water in the canals, which, compared to their original form, 

have undergone generalizations and improvements over time. 

The Saint-Venat equations are in fact a system of equations with partial derivatives of 

the second order, nonlinear, of hyperbolic type: 

 the continuity equation, expressing the principle of conservation and continuity of the 

liquid phase: 

∂
𝜕𝑄

𝜕𝑥
+

𝜕𝐴

𝜕𝑡
= 0;               (2-1) 

  the momentum equation, expressing the principle of conservation and continuity of 

energy: 
𝜕𝑄

𝜕𝑡
+

𝜕(𝑄·𝑉)

𝜕𝑥
+ 𝑔 · 𝐴 · (

𝜕ℎ

𝜕𝑥
− 𝑆0) + 𝑔 · 𝐴 · 𝑆𝑓 = 0;               (2-2) 

where: S0 represents the slope of the riverbed, Sf - the friction slope, V is the speed 

considered uniform in cross section, and A – cross section area; V and A are functions of x and 

t, so the flow rate will be: 
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𝑄 =  𝐴 ·  𝑉 = 𝑄(𝑥, 𝑡)                               (2-3) 

The exact solution of the Saint-Venant system of equations, in the sense of obtaining 

unknown values (dependent variables) at all points of the plane of the independent variables is 

practically impossible. 

  

 

3. TWO-DIMENSIONAL HYDRODYNAMIC MODEL DEVELOPMENT 

 

3.1. General Notions 

 

In recent decades, remarkable progress has been made in the study of flow and sediment 

transport processes on rivers and streams, by using flow modeling tools, riverbed morphology 

and sediment transport. 

In general, when modeling watercourses, the most used are one-dimensional (1D) 

models, which are based on the equations of uniform flow and those of uniform-varied flow. 

These models have the following advantages: simplicity of calculations, ease of 

parameterization, easy calibration, fewer of data required for calibration / validation [9]. 

The development of a numerical model of fluid mass displacement, especially during 

floods, is a complex process, as it is based on the Saint-Venant system of equations, which 

involves parameters such as roughness in each calculation section. These parameters are 

different for the low-flow channel, respectively for the flood plain, or they can be considered 

vertically variable. Their calibration involves adjusting their values (within acceptable limits) 

until accurately reproducing the levels recorded for situations that have been very well 

monitored. 

2D hydrodynamic propagation models are able to reproduce spatially distributed 

phenomena in a very realistic way, although they are more difficult to calibrate and validate 

than 1D models, as the necessary data is obtained through modern measurement technologies. 

In addition, 2D hydraulic models require a longer calculation time, and the data required for the 

construction of the geometry must have a much larger spatial distribution [9]. 

Two-dimensional models can be divided into three categories: quasi-2D models, full 2D 

models and combined 1D-2D models. There are also situations in which a three-dimensional 

approach to the flow is required, especially when it passes from the riverbed to the floodplain 

[10]. 

 

3.2. The Objectives of the Research 

 

Within the research project entitled "Contributions Related to Usage of Geodetic 

Measurements to Sediment Transport Modeling on the Danube River", which aims to identify 

measures to contribute to the stabilization of the Danube riverbed, the objective of the research 

report no. 2 - " Bathymetric Modeling - The Premise for Creating Flow and Sediment Transport 

Models" is the creation of a complex hydrodynamic (2D) model of the analyzed Danube River 

sector, based on various types of geodetic measurements to determine the necessary elements 
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(types of geodetic measurements were presented in detail in Research Report No. 1 - “Current 

Status of Geodetic Measurements and Coordinate Reference Systems”).  

The results of this report will be used further in the research report no. 3 - "Case study 

and interpretation of results", which will address in particular the issue of modeling sediment 

transport on the Danube River, by creating an erosion model, followed by its calibration and 

validation. 

 

3.3. Study Area  

 

The area selected to elaborate a complex hydrodynamic and sediment transport model 

refers to the Danube critical sector extended between Bechet Gauge Station (rkm 625) and 

Corabia Gauge Station (rkm 678) (Figure 2). 

 
Figure 2. Study Area 

With a length of 53 km, this sector is part of the Lower Danube and it can be considered 

relevant for research because of the difficult navigation conditions, which are consequence of 

the complexity of the hydraulic regime and the dynamic changes of the riverbed morphology, 

with damaging effects on the fairway3. 

Economically viable Danube transport services are dependent on the conditions of a 

stable fairway. Along the Danube, navigation is impeded by several critical navigation points 

                                                           
3 The fairway is a navigable section along a watercourse, canal or lake. It is continuous, sufficiently wide and deep 

to ensure the movement of ships, the entry of ships into port or their passage through a narrow place. The fairway 

is maintained and marked for the purpose of safe navigation. Source: www.wikipedia.org. 
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(bottlenecks), both during winter and ice conditions, and during late summer when river flows 

tend to be very low (below 3000 mc/s). 

In accordance with the provisions of the "Convention regarding the regime of navigation 

on the Danube", signed in Belgrade on August 18, 1948, ensuring the conditions of navigation 

on the Danube sector between km 845.5 and km 375 is the responsibility of the two riparian 

countries, Romania and Bulgaria. 

Based on the Romanian-Bulgarian Bilateral Agreement, signed in Sofia on November 

28, 1955, the two states defined their areas of responsibility, on the common sector of the 

Danube, as follows: 

 between km 845.5 and km 610, the responsibility for maintaining the waterway belongs 

to the Romanian side; 

 between km 610 and km 375, the responsibility for maintaining the waterway belongs 

to the Bulgarian side. 

The Galati Lower Danube River Administration (GLDRA) - AFDJ Galați (Romania) 

and IAPPD Ruse (Bulgaria) are the authorities responsible for maintaining adequate navigation 

conditions. 

The Galati Lower Danube River Administration (GLDRA) is the waterway authority on 

the entire Romanian sector of the Danube. In order to ensure the minimum navigation 

conditions, recommended by the Danube Commission, maintenance works are performed 

(measurement activities, signaling and dredging), which are effective only for a short period of 

time. 

Therefore, in 2017 the project “FAST Danube” was launched - “Technical assistance 

for the revision and completion of the feasibility study on improving navigation conditions, on 

the joint Romanian-Bulgarian Danube River sector and complementary studies”, to study the 

geomorphological conditions and hydrological factors that influence this sector of the Danube, 

in order to develop complex technical solutions that will help improve navigation conditions 

and at the same time have a minimal impact on the environment. 

As a result of a feasibility study completed in 2011 (necessary to launch the FAST 

DANUBE Project), in the river sector downstream of the Iron Gates II, in the common 

Romanian-Bulgarian sector (km 845.5 - km 375), 12 critical points for navigation were 

identified (Table 1), which requires close monitoring through a series of topo-hydrographic 

measurements. 

  

Table 1 – Critical points for navigation 

NO. NAME 
LOCALIZATION 

(RIVER KM) 

ADMINISTRATIVE  

TERRITORY 

1 Gârla Mare km 839 – km 837 Romania 

2 Salcia km 824 – km 820 Romania 

3 Bogdan-Secian km 786 – km 782 Romania 

4 Dobrina km 762 – km 756 Romania 

5 Bechet km 678 – km 673 Romania 

6 Corabia km 632 – km 626 Romania 

7 Belene km 577 – km 560 Bulgaria 
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NO. NAME 
LOCALIZATION 

(RIVER KM) 

ADMINISTRATIVE  

TERRITORY 

8 Vardim km 542 – km 539 Bulgaria 

9 Iantra km 537 – km 534 Bulgaria 

10 Batin km 530 – km 520 Bulgaria 

11 Kosui km 428 – km 423 Bulgaria 

12 Popina km 408 – km 401 Bulgaria 

As a result of this study, the Danube Commission recommended for the Romanian-

Bulgarian sector a channel width of 180 m, with a minimum depth of 2.5 m and a minimum 

radius of curvature of 1000 m. For areas where minimum depths are not ensured (Figure 3) it 

was proposed to reduce the width of the fairway to 150 m. 

 

Figure 3. Location of the 12 critical points in the Romanian and Bulgarian sector 

Source: http://www.fastdanube.eu/official-documents 

Therefore, the Bechet-Corabia study area is part of the critical areas for navigation 

(Table 2), established, according to the same feasibility study, as follows: 

Table 2 – Critical areas for navigation 

CRITICAL 

AREA NO. 
LENGTH (RIVER KM) 

CRITICAL POINTS INCLUDED IN 

CRITICAL AREA 

ZC1 km 850 – km 818 Gârla Mare, Salcia 

ZC2 km 786 – km 755 Bogdan-Secian, Dobrina 

ZC3 km 678 – km 625 Bechet, Corabia 

ZC4 km 577 – km 520 Belene, Vardim, Iantra, Batin 

ZC5 km 428 – km 401 Kosui, Popina 

 

http://www.fastdanube.eu/official-documents
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3.4. Model Input Data 
 

The understanding of river morphological processes in order to develop a  

hydrodynamic model, as well as key processes such as sediment erosion, transport and 

deposition, represents a particularly difficult task, which requires a huge amount of data 

collected during field campaigns and interdisciplinary knowledge, at the border between 

Geodesy, Hydrology and Hydraulics. 

The quality of mathematical modeling and the spatial representation of its results are 

closely related to the input data used. The quality of these data is all the more important as they 

directly influence the representation of natural phenomena in a form as close as possible to 

reality. 

Consequently, there is a great demand for accurate and precise information, in order to 

minimize the uncertainties resulting from the simulations.  

 

3.4.1. Topographic Data  

The starting point in the elaboration of any hydrodynamic model of flow is the data 

related to the terrain, the topography of the terrain and the land cover [11]. 

Depending on the type of mathematical modeling used, namely one-dimensional or two-

dimensional, the required topographic data are different. 

1D modeling lends itself to a classical collection approach, where data collection 

methods using GNSS technology and the total station will replace airborne LiDAR and aerial 

photogrammetry, used to obtain geospatial data needed for 2D modeling [12]. 

To generate a one-dimensional model of rivers, longitudinal and cross section graphic 

profiles are required, the latter being arranged perpendicular to the longitudinal axis of the river, 

and their position and density are chosen depending on the terrain configuration and the 

importance of their area. The required accuracy must be taken into account when collecting the 

data, as it plays an essential role in the choice of equipment and measurement methods. 

The final processing of data for its use in 1D mathematical modeling programs of rivers 

contains several independent steps, many of which being manual processing which is time 

consuming and facilitates human errors. Also, this method does not offer a high yield. 

In the case of two-dimensional models, the cross sections/bathymetric measurements in 

the low-flow channel are coupled with topographic data sets in the floodplain, in order to obtain 

a continuous Digital Terrain Model (DTM) [11]. Topographic data is collected separately for 

dry and water-covered areas and are also processed separately. However, they must be included 

in a unitary DTM, covering the entire study area. 

In this case, for the two-dimensional hydraulic modeling of the Danube sector Bechet-

Corabia (53 km long), the digital terrain model was kindly provided to us by GLDRA (S.C.N. 

Giurgiu), the beneficiary of the Fast Danube project. 

This DTM was obtained based on data collected by LiDAR (Light Detection and 

Ranging) technology, combined with topo-geodetic and bathymetric data, covering the entire 

river channel, the adjacent river banks and adjoining land up to a minimum distance of 250 m 

from the edge of the river on both sides.  
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a) Establishment of Reference Geodetic Benchmarks 

Within the project “BORD – Development of a support system for hydrographic works 

on the Danube in order to ensure minimum navigation depths”, whose beneficiary is the 

Romanian state and the contracting authority is LDRA Galati, the main objective was the design, 

execution and materialization of three geodetic landmarks (Witness Landmark, Reference 

Landmark and Azimuthal Landmark) in 144 locations along the Romanian sector of the 

Danube. The system, called AFDJ2014, is therefore defined by the 144 locations, located less 

than 15 km from each other.  

 

Figure 4. AFDJ2014 Geodetic Network 

    

The final coordinates of the landmarks were provided both in ETRS89 system (to 

facilitate interconnection with neighboring countries) and in the national reference system S42 

(with the 1940 Krasovski ellipsoid and 1970 stereographic projection system). In addition to 

the set of planimetric and geodetic coordinates (determined with GNSS technology), the height 

in the system of normal heights - Black Sea 1975 was also determined for each landmark (the 

elevation was transmitted by geometric leveling from landmarks in the national network), 

which then was transformed with TransDatRo into the EVRF2007 system (Amsterdam 

fundamental “zero” point). 

Also through the TransDatRo software, the planimetric coordinates were calculated in 

the UTM (Universe Transverse Mercator) projection system. 

This support network is the basis for the correct redetermination of the “zero” height of 

the staff gauges, thus making it possible to determine as accurately as possible the (absolute) 

height of the free surface of the water. 

These reference points were also used as base stations where GNSS equipment was 

installed to generate differential corrections, which were then transmitted by radio waves to the 

GNSS receiver in the sonar-equipped boat (from which bathymetric measurements were made). 

The accuracy of determining these points, especially the elevations, significantly influences the 

final results: the DTM and the mathematical model of the flow.  

On the analyzed sector, Bechet-Corabia, there are six locations (Figure 4) where 

landmarks from the AFDJ2014 support network were located (91-86). 
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b)  LiDAR data 

The LiDAR technique involves the existence of a laser sensor mounted with great 

precision on an airplane, helicopter or UAV (Unmanned Aerial Vehicle - drone), which 

transmits during the flight a laser wave to the ground and a receiver mounted behind the plane 

receives the reflected laser waves.  

Most LiDAR systems use a scan mirror to generate a laser pulse swath. The length of 

the swath depends on the angle of oscillation of the mirror, and the density of the ground points 

depends on factors such as the speed of the plane and the rate of oscillation of the mirror. 

Distances are determined by calculating the time it takes for the laser signal to travel the 

distance from the transmitter sensor to the ground and back to it. 

In addition to the laser scanning system (Laser Scanner - Figure 5), the LiDAR 

technique is based on the GNSS / IMU couple (Global Navigation Satellite System / Inertial 

Measurement Unit), which helps to determine as accurately as possible the position and 

orientation of the system. 

The GNSS system consists of an airborne GNSS antenna (GNSS Receiver), mounted in 

a visible position at the top of the aircraft, providing sufficient aperture to the satellites to record 

the continuous position of the aircraft, and a GNSS station located on the ground (GNSS 

Reference Station), with the role of correcting the measurements of the GNSS antenna, so as to 

obtain the best possible trajectory of the aircraft (GNSS data are processed by differential GNSS 

methods). 

The IMU system (Inertial Measurement Unit) consists of a set of gyroscopes and 

accelerometers that continuously measure the height and acceleration of the aircraft 

(http://www.geo-spatial.org/). 

 

Figure 4. Components of the LiDAR system 

Source: https://www.yellowscan-lidar.com/ 

 

Currently, laser scanning technology provides high-resolution topographic data and is 

able to quickly cover large areas, at moderate costs, with high accuracy in both horizontal and 

vertical planes, significantly contributing to the representation of terrain surfaces. 

The three-dimensional coordinates (x, y, z or latitude, longitude and altitude) of the 

points corresponding to the measured objects are calculated using three main elements, namely: 

the time difference between the emission and return of the laser pulse, the angle at which the 

laser pulse was emitted and the exact location of the sensor on or above the Earth's surface. 

http://www.geo-spatial.org/
https://www.yellowscan-lidar.com/
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Although this technology has some limitations due to the fact that the laser pulse does 

not penetrate deep water, it is certainly a useful tool for generating digital terrain models with 

high accuracy in complex areas such as floodplains or river islands. 

Within the “Fast Danube” project, in 2017 two scanning campaigns were carried out 

with aircraft equipped with LiDAR systems, in April and July, the objective being to cover at 

least 200 m from the water limit on each side of the Danube (on the joint Romanian-Bulgarian 

sector) and to scan  the river islands covered with forest vegetation. 

To ensure the best input for the modeling process, the area of interest was extended to 

250 m from the first firm shore (sandy areas were considered part of the body of water), 

eventually resulting in a scanned area of 1013 km2. 

Data obtained during the first survey campaign were used to calibrate the 2D models, 

while data obtained in the second campaign were used to validate the 2D models.  

The aircrafts used for LiDAR scanning were SP-FPL-Cessna T206H (Figure 6) and SP-

FPK Piper Navajo PA-31 (Figure 7).  

 

 

Figure 5. Cessna T206H, modified for LiDAR 

scanning 

 

Figure 6. Piper Navajo PA-31, modified for 

LiDAR scanning 

 Source: http://www.fastdanube.eu/official-documents 

 

They had identical scanning systems installed, consisting of the LiteMapper 6800i 

scanner (Figure 8) and the AeroControl series IIe 256Hz GPS / IMU system. 

The LiteMapper 6800i system consists of the latest generation Riegl LMS-Q680i 

scanner, which uses the principle of continuous wave measurement and has the innovative 

Multi-Time Around function, which allows the acquisition of data from high flight altitudes, 

up to 3000 m AGL (Above Ground Level), depending on the scanned area. 

The starting point for making the flight plans was the scanning density, the target set 

being 4 points / m2, but the final analysis showed that the density varied depending on the 

vegetation cover of each area. 

The width of a scanning swath was 570 m (for an average altitude of 690 m AGL and a 

scanner opening angle of 45⁰). The average speed was 125 kts (231.5km / h). 

The main result of these LiDAR scans is the 3D point clouds, that is hundreds of millions 

of points containing information such as x, y, z.  

http://www.fastdanube.eu/official-documents
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This huge volume of data could only be manipulated and processed with the help of 

powerful graphics stations and dedicated software products: RiAnalyze, RiWorld and 

RiProcess for LiDAR data processing, and FugroViewer for point cloud visualization.  

 

 

Figure 7. LiteMapper 6800i LiDAR system installed in the plane 

Source: http://www.fastdanube.eu/official-documents 
 

The calibration of LiDAR measurements was performed based on permanent GNSS 

stations and ground-based control surfaces. 

Unlike traditional topographic measurement techniques, this technology has offered the 

possibility of generating a high resolution DTM (0.5 m x 0.5 m) directly from the point cloud, 

following multiple stages of data processing, by applying filtering, segmentation and 

classification algorithms of the point clouds. 

The verification of the accuracy of the obtained coordinates and the evaluation of the 

quality of DTM derived from LiDAR data was done by applying reliable tests, based on the 

data sets measured in the field. 

During the ground measurement campaign, for the creation of the ground control base, 

the equipment used consisted of: Trimble R8s GPS receiver compatible with ROMPOS (Figure 

9), Trimble M3 total laser station (Figure 10) and a transport vehicle.  

 

 

 

 

 

          

Figure 8. Trimble R8s with TSC3 controller     Figure 9. Trimble M3 total station 

                                           Source: https://www.trimble.com/ 

 

 

http://www.fastdanube.eu/official-documents
https://www.trimble.com/


   Research report no. 2  

  Bathymetric Modeling - The Premise for Creating Flow and Sediment Transport Models 

19 
 

c) Data from bathymetric measurements 

Along with LiDAR scans, within the FAST DANUBE project, two bathymetric survey 

campaigns were carried out along the Romanian-Bulgarian common sector of the Danube river, 

in April-May 2017 (68 days - from downstream, from Călărași, to upstream, at the Iron Gates 

II), respectively July-August 2017 (47 days - from upstream, from the Iron Gates II, to 

downstream, to Călărași). 

Hydrographic, hydrodynamic and sediment data were collected simultaneously. 

Throughout the bathymetric determinations, the ANR 1979 laboratory ship was used as a 

mobile support base, being stationary every 10-12 km (Figure 11). 

 

 

          Figure 10. ANR 1979 laboratory ship 

Three motorboats (Figure 12. a, b, c) equipped with Kongsberg GeoSwath Plus 

interferometric sonar, operating at 250 kHz and 500 kHz, were used to collect hydrographic 

data. A higher frequency provides better resolution, but at the same time limits the range. 

Therefore, the difference between the two frequency classes lies in the swath width. 

 

  
 

  

                           a)                              b)                                                                 c) 

Figure 11. Motorboats used 

a) Buster XL  b) Shadow  c) ZOPEDA 

Source: https://marine-research.com/ 

The 500 kHz frequency was used in shallow water and cross sections, and the 250 kHz 

frequency for scanning deep-water areas and the fairway, all teams using GS4 software for data 

acquisition, calibration and processing. 

https://marine-research.com/
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 Kongsberg GeoSwath Plus interferometric 

sonar (Figure 13) consists of: transducer, deck unit and 

GNSS receiver. The transducer is the submerged part of 

the assembly, which emits and records the acoustic 

signal returned from the substrate, being connected to 

the processing unit located on the ship.  

To calculate the distance to the target, the 

transducer has a mini SVS (Sound Velocity Sensor) 

connected to continuously determine the speed of sound 

propagation in the water column, which is then 

introduced as a correction in the processing. The MRU 

(Motion Reference Unit) assembly of inertial position 

sensors and boat movement compensation is also attached on the “transducer”. 

Figure 12. Kongsberg GeoSwath Plus interferometric sonar components 

Source: Alfred Wegener Institute Helmholtz Center for Polar and Marine Research 

As a mode of operation, the interferometric sonar is similar to the side-scan sonar4, 

because the acoustic pulses are emitted similarly, but for the reception of reflected signals a 

matrix of several transducer elements located at well-defined distances is used (Figure 14). The 

depth of the different points on the bottom of the riverbed (or sea) is precisely calculated by 

measuring the phase difference between the received signals at the level of the transducer 

elements (corresponding to the same point), from which it results the angles between them, and 

by knowing the exact speed of sound propagation in the water column (approximately 1500 m 

/ s) and the time elapsed between the transmission and reception of the signal. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Figure 13. How the interferometric sonar works 

Source: International Hydrographic Organization 

                                                           
4 Side Scan Sonar was described in Research Report no. 1 - “Current status of geodetic measurements and 

Coordinate Reference Systems” (p.115).  
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On the other hand, artificial satellites evolving in outer orbit emit satellite signals 

broadcast in the microwave field, continuously or by pulses at regular intervals, which are 

received by the GNSS receiver, which decodes this signal to extract the information needed to 

determine position of the receiver, transmitting to the sonar the position coordinates and the 

time at which the determination was made. 

In order to reduce positioning errors (within the limit of 3 ÷ 5 m), the differential 

corrections received from the base stations on the shore (points in the support geodetic network 

AFDJ2014) were used, in which GNSS equipment was installed (Figure 15). Following these 

corrections, a horizontal accuracy of 16 mm + 1 ppm from base length (base station-rover 

distance) and a vertical accuracy of 30 mm + 1 ppm from base length resulted. 

Because the GNSS receiver and the sonar, although having different reference systems, 

perform measurements on the same point, it is necessary to correlate the data provided by the 

two pieces of equipment, so that a point with planimetric coordinates determined by GNSS 

technology is associated with the corresponding value of the depth measured by the sonar [13]. 

According to the technical documentation of the system, the accuracy of measuring the 

depth with GeoSwath Plus systems is 3 mm. 

 

 

Figure 14. Transmission of differential corrections from shore base stations 
 

When performing bathymetric measurements, it was decided to use interferometric 

sonar to the detriment of multibeam sonar for the following reasons: 

• Interferometric sonar can also chart the banks up to the surface of the water due to the 

large beam transmission angle (240 degrees); 

• Interferometric sonar offers a coverage of up to twice as much as the classic 

multibeam, being much more efficient in terms of time required and implicitly the related costs; 

• Interferometric sonar provides a large number of measured points, over 5000 along the 

scanned swath, for each ping (sound wave emission). For the depth range foreseen for 

measurement, at least 10 pings / s are emitted, which means 7-8 pings / linear meter of profile, 

resulting in 400-800 measured points / sqm; 

• Depth is measured up to the surface of the water at a safe navigation distance from 

dams or underwater obstacles; 
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• Interferometric sonar is specially designed for operation in shallow and very shallow 

waters, while conventional multibeam sonar offers low coverage in these areas. 

Data obtained from LiDAR surveys were combined with bathymetric and topographic 

data to produce a continuous DTM of high accuracy and resolution (50 cm grid), which covers 

the entire study area (Figure 16) - the low-flow channel and 250 m from the edge of the river 

on both sides.     

 
 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

Figure 15. Unified DTM visualization and analysis using Global Mapper software 

 

Finally, in order to assess the quality of the unified DTM, an analysis was performed on 

the connection areas of the DTM obtained from LiDAR data with the DTM obtained from 

bathymetric measurements and the global indicators of precision and accuracy were determined 

in accordance with the provisions of the tender book.   

 

3.4.2. Hydrological data 

 

 The hydrological data necessary for the building of the 2D hydrodynamic model, 

respectively for establishing the boundary conditions were obtained from the archive of the 

National Institute of Hydrology and Water Management (NIHWM) and LDRA Galați. All 

collected data were reorganized and processed by statistical-mathematical methods (Microsoft 

Excel 2014). It consists of: 

 Daily-mean liquid flows and daily-mean levels from Bechet and Corabia Gauge 

Stations for 2017 (source: NIHWM); 

 Rating curve from the Corabia gauging station valid for 2017 (source: NIHWM); 
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 The roughness coefficients for the low-flow channel and for the flood plain, 

established following the analysis of several data sets provided by LDRA Galați - 

S.C.N. Giurgiu and the Corine Land Cover (2012-2018) .shp file with land cover. 

 The rating curve from Corabia gauging station was purchased in tabular form, in .jpg 

format, and the levels were relatively expressed. The transformation of these relative values 

into absolute heights (Black Sea 1975 Height System) was possible by referencing to the “zero” 

height of the staff gauge corresponding to the Corabia Gauge Station (source: NIHWM) - Figure 

17.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

3.4.3. Geospatial database 

The issue of sediment transport modeling on the Danube and improving, in general, 

waterway maintenance processes is of great interest, although it has been addressed in the past 

in several research projects and programs.  

Building the mathematical model is a very important step in achieving the objectives of 

this research project (presented in the Project of the scientific research program, 2018).  

Figure 16. Example of analysis and processing of raw data for use as input data in the 

mathematical model 
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For this purpose, bibliographic materials were consulted to provide a general framework 

for research: doctoral theses, specialized journals, geography treatises, hydrological studies, 

regional studies, websites, etc. 

The documentation phase for the elaboration of this research report culminated with 

the creation of a database containing as detailed information as possible on the Danube River 

in general and the Bechet-Corabia sector in particular. 

The geospatial data in vector file formats were organized in thematic layers (Table 3), 

which would allow analyses in the GIS (Geographic Information System) environment. 

Usually, the basic sources are raster data, which is vectorized, resulting in other data to 

which an attribute table with several characteristic fields is added. These fields are in turn used 

for design (labels, classifications) or to generate new information. 

 
Table 3. Primary spatial database used in the study 

PRIMARY DIGITAL DATA FORMAT DATA SOURCE 

Hydrographic network Vector; line 
Vectorization of the 1:25000 topographic 

map 

Gauge stations Vector; point NIHWM Database 

Localities Vector; point geo-spatial.org 

State border Vector; polygon geo-spatial.org  

W.B.A. Limits Vector; polygon NIHWM Database 

River Basins Vector; polygon NIHWM Database 

Banks Vector; line 
Vectorization of orthophotoplanes with a 

resolution of 0.5 m (2013-2017 edition);  

Flood Plain Vector; line 
Vectorization of orthophotoplanes with a 

resolution of 0.5 m (2013-2017 edition); 

Thalweg Vector; line LDRA Galați (Fast Danube Project) 

River Islands Vector; polygon 
Vectorization of orthophotoplanes with a 

resolution of 0.5 m (2013-2017 edition);  

Dykes Vector; point NIHWM Database 

Level Curve Vector; line 
Vectorization of the 1:25000 topographic 

map 

Land Use Vector; polygon 
Vectorization of Corine Land Cover 2012-

2018 

Soils Vector; polygon Vectorization of the 1:200000 soil map 

Geology Vector; polygon 1:200000 Geological Map of Romania 

 

Until the completion of the research project, this database will be constantly completed 

and updated, because the application of specific GIS operations on raw vector data can generate 

data in raster format, much more useful for analysis and predictions on certain current 

geomorphological processes, existing the possibility to process it in order to simulate the 

conditions in the field and to quantify their influences in the triggering and evolution of some 

processes invisible to the human eye or not represented on the topographic map.  
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3.4.4. Other Data Sources 

 

In general, hydrological processes, both those that characterize liquid runoff and those 

that describe alluvial runoff, take place at the scale of river basins and are determined by a 

number of environmental factors, the most important of which being the lithological substrate 

(geology), geography, soils, land use, climatic elements and groundwater. 

Except for the parameters considered input data for the two-dimensional hydrodynamic 

modeling of the Bechet-Corabia Danube River sector, analyzed in this Research Report, we 

will return to the other ones in the Research Report no. 3 - Case study and interpretation of 

results”, which has as main objective the modeling of sediment transport on the Bechet-Corabia 

Danube River sector.    

 

3.5. Work Stages  

 

To describe and exemplify the ways in which hydrodynamic factors act on the riverbed 

and implicitly on the formations specific to the riverbed, specific methods of hydraulic 

modeling corroborated with geospatial techniques were used. 

 

3.5.1. Specialty Software Used  

 

The following GIS applications were used for digitizing, processing and exporting data 

required for bathymetric modeling, as well as for spatial transposition of data and information 

into sketches and maps: ArcMap 10.5, ArcGIS PRO 2.1 and Global Mapper v18. 

The 2D hydraulic model of the studied area (Bechet-Corabia) was developed using the 

MIKE 21 Flow Model (FM) hydrodynamic module from the Mike 21 software package, 

developed by the independent international consulting and research organization DHI for 2D 

modeling of rivers, waves, sediment transport, water quality and advection / dispersion 

(https://www.mikepoweredbydhi.com/). 

The MIKE 21 Flow Model HD FM solution is based on the integrated Navier-Stokes 

equations in relation to depth (for free surface flow) and uses a finite element network (Flexible 

Mesh) [14]. The program calculates the water level, depth, velocity and direction of each finite 

element of the model network and at each time interval of the model simulation. 

MIKE 21 FM also allows the simulation of sediment transport using a non-cohesive 

sediment transport module (“Sand Transport”), a cohesive sediment transport module (“Mud 

Transport”) and a morphology module for updating the elevations in the during model 

simulation). 

The FM module in the MIKE 21 package allows a better simulation of the combined 

coarse and fine sediment systems than other 2D flow modules, such as the MIKE21C package 

(which uses a curvilinear mesh network), where the simulation of fine sediment transport is 

simpler.  
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3.5.2. Geospatial Data Preprocessing Using GIS Applications 

The most important parameter in the construction of the two-dimensional hydrodynamic 

model of the flow is the coupled bathymetry and floodplain topography or the integrated Digital 

Terrain Model (DTM). As previously mentioned, the DTM corresponding to the Bechet-

Corabia sector covers the low-flow channel and 250 m from the water boundary. It comes from 

the processing and unification of LiDAR data and bathymetric data, being a unitary DTM of 

high accuracy and high spatial resolution: 0.5 m x 0.5 m. 

In most cases, the 2D hydraulic modeling process requires a hardware component with 

a special configuration, so that the export / import of data and simulations over large areas can 

be performed in a reasonable time. 

Since we had a high-performance computer, but not a graphics station (Workstation) 

built and prepared to withstand continuous demands throughout the day, we opted for 

resampling DTM at a spatial resolution of 1 m x 1 m. 

First, the resizing of the DTM (raster file) according to the study area was performed 

using the Extract by Mask tool from the Spatial Analyst Module in ArcMap 10.5, then the 

Resample function was accessed (Fig. 18) from ArcToolbox: Data Management Tools → 

Raster → Raster processing → Resample. At “input” the Digital Terrain Model was selected, 

for X and Y we entered the value 1, and at Resampling Technique the Nearest method was 

selected. 

 
Figure 17. DTM resampling using the Resample function  

Global Mapper software was used to convert this raster file from .img format to the 

format supported by Mike 21, namely xyz, following the steps File → Export → Elevation Grid 

Format → XYZ Grid. The resulting xyz file contains over 100 million values. 

The vectorization of the river banks, the flood plain or fluvial islands (Figure 21) was 

performed in ArcMap 10.5, based on the DTM, the orthophotoplanes 2013-2017 edition (Figure 

20), with a spatial resolution of 50 cm, made by the Military Topographic Directorate, but also 

based on Sentinel 2 satellite images (Figure 19) corresponding to the measurement campaign 

period. 
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The Shape to XYZ Conversion tool created by DHI was used to export shapefile data in 

xyz format (the maximum distance allowed between points was 100 m). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The last step in preparing the data before importing it into Mike 21 was to create the xyz 

file with the values of the Manning roughness coefficient (M = 1 / n, where n is the roughness 

coefficient), which differs for the main channel, islands and flood plain, with values included 

in the interval 10 - 38.46 (Figure 22). The lower the value of the Manning number, the higher 

the resistance of the terrain (respectively the discharge rate decreases) [15]. 

 

Figure 21. Roughness coefficients for flood plain, low-flow channel and islands 

Figure 19. Vectorization of shores, flood plain 

and river islands based on DTM, 

orthophotoplane and Sentinel 2 satellite images 

(IR band) 

Figure 20. DTM superimposed over orthophotoplane 

Figure 18 - Sentinel 2 satellite image (IR - 

bands 8, 4, 3) 
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3.5.3. Creating a Computational Mesh in Mike Zero  

In Mike Zero (name of the DHI graphical interface from which all available modules 

are accessed: Mike HYDRO, Mike 11, Mike 21, Mike 3, Mike Flood, Mike SHE etc.), select 

New → File → Mesh Generator. 

The first step in obtaining the flexible (triangular) grid of finite elements is the setting 

of the cartographic projection, namely “Stereo_70” in the case of this study. 

The next step is to import the boundaries of the work domain in Mesh Generator: Data 

→ Import Boundary (xyz files for low-flow channel, fluvial islands and floodplain previously 

exported from GIS environment). In “Boundary properties” select “X, Y, Connectivity and Z” 

(Figure 23). 

 

 

Figure 22. Setting the projection and xyz file type 

It is very important to mention that “Exclude from mesh” will be ticked for all islands 

and “Apply triangular mesh” only for the main channel, because it is assumed that during low 

and medium water does not flow over those island formations covered with vegetation. 

After editing the vertices and nodes of the domain boundaries, the finite element grid 

will be generated as follows: Mesh → Mesh Generation (Figure 24), with the following 

settings: 

- Maximum element area: 5000 m2; 

- Smallest allowable angle: 30; 

- Maximum number of nodes: 80000. 

 

 

Figure 23. Mesh network generation 
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Through this operation, the model domain is represented by a network of interconnected 

triangular finite elements (Figure 25). Such a network is automatically generated by the 

computer system, and the resolution of the model is controlled by specifying the maximum area 

that an individual element can occupy in the network. For example, if the maximum area of the 

element has been set to 5000 m2, then each element in the network will have an area of no more 

than 5000 m2. The resolution of the network can vary in different parts of the modeled domain 

(at the end I also applied the “Smooth Mesh” function). As the cell size decreases, both the 

number of elements in the model and the computation time required for model simulations 

increase.   

 

 

Figure 24. Network of interconnected triangular finite elements (Triangular Mesh) 

After this step, the points resulting from the export of the DTM in xyz format were 

imported into the Mesh, by accessing the “Manage Scatter Data” tool from the Data menu 

(Figure 26).  

 

 

Figure 25. Importing the xyz file with the points extracted from the DTM 
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Interpolating these millions of points using the "Interpolate" function in the "Mesh" 

menu is the last step in obtaining the bathymetry file. The elevations of the points are expressed 

in the 1975 Black Sea Height System (Figure 27). 

The result was later exported by accessing the menu Mesh → Export Mesh → Mesh File 

(Item type - Bathymetry). 

 

 

 Figure 26. Mesh file for bathymetry in the Danube River sector Bechet - Corabia 
Similarly, the xyz file with the Manning roughness coefficients - bed resistance (created 

in ArcMap) was imported into the Mesh: Data → Manage Scatter Data (Figure 28).  

 

 

Figure 27. Importing the xyz file with the Manning roughness coefficients 
These values were interpolated, and the result was exported as a DFSU Data-file, 

according to Figure 29 (from the Mesh → Export Mesh menu), a Mike-specific format, with the 

specification "Manning's M" for Item type.      

 

Figure 28. dfsu file for the roughness of the Danube River sector Bechet - Corabia 
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3.5.4. Boundary Conditions Input 

The establishment of Boundary conditions for the model refer to: 

 The hydrograph of daily-mean flow at Bechet gauge station (upstream) on the Danube 

river, available for the simulation period (23.04.2017 – 05.06.2017); 

 The rating curve at Corabia gauge station (downstream) on the Danube river. 

It is also necessary to introduce an Initial Condition consisting of: 

 The mean annual flow for 2017 at Bechet gauge station (upstream) on the Danube river, 

with a value of 4461 m3/s, which is used in steady state simulation to produce a hot-start, 

used later for flow propagation; 

 The rating curve at Corabia gauge station (downstream) on the Danube river. 

To set the boundary conditions using Mike, it is necessary to create certain .dfs0 files, 

both for the discharge hydrograph at Bechet Gauge Station (Figure 30), as well as for the rating 

curve at Corabia Gauge Station (Figure 31).  

a) For discharges: 

 From Mike Zero we select New → File → Time Series (.dt0, .dfs0) → Blank Time 

Series, and in the window that opens, the following settings are made for the axis type, 

start date, time step, number of time steps, file name, record type, measuring unit: 

 Axis Type: Equidistant time axis; 

 Start time: 23.04.2017 (the period in which the bathymetric measurements were 

performed, source: http://www.fastdanube.eu/); 

 Time step: 1 day; 

 Number of Time Steps: 44; 

 Name: Bechet Discharges; 

 Type: Discharge; 

 Unit: m3/s; 

The discharges entered in the .dfs0 file must be those recorded at Bechet Gauge Station 

during the simulation period (23.04.2017 - 05.06.2017) of the model. 

 

Figure 29. DFS0 file with hydrograph of the daily-mean flow recorded at Bechet Gauge Station 
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b) For the rating curve: 

 From Mike Zero we select New → File → Time Series (.dt0, .dfs0) → Blank Time 

Series, and in the window that opens the following settings are made: 

 Axis Type: Relative Item Axis; 

 Number of Time Steps: 467 (how many rows are in the rating curve in .xls format); 

 Axis Units: m; 

 Name: Corabia rating curve; 

 Type: Water level; 

 Unit: m; 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 30. dfs0 file with rating curve valid for 2017 at Corabia Gauge Station 

 

The .dfs0 file with the rating curve valid for 2017 at Corabia Gauge Station will be used 

both for running the initial condition (with constant flow), and for the boundary condition 

downstream. 

 

3.5.5. Set-up of Mike 21 Flow Model (FM) 

 

The dialogue for setting-up the Mike 21 FM model, is initiated from MIKE Zero: MIKE 

Zero → Mike 21 → Flow Model FM, then the window in Figure 32 will open: 

 

Figure 31. Mike 21 FM Module 
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The following information and data sets are required: 

 Domain: the .mesh file previously created for the bathymetry of the Bechet-Corabia 

Danube River sector; 

 Time: 23.04.2017 - 05.06.2017, meaning 44 days, with a time step of 30 s, resulting in 

a total number of time steps of 123840; 

 Selected module: Hydrodynamic. 

 

 The Hydrodynamic module was set as follows: 

 

 Technical Solution: Low order, fast algorithm (in this way the simulation is faster); 

 Flood and dry: Drying depth - 0.01m; Wetting depth - 0.1 m; 

 Density: Barotropic; 

 Eddy Viscosity: Constant eddy formulation; 

 Bed resistance (roughness): Manning number - the previously created .dfsu file was 

introduced; 

 Initial condition: the .dfsu file resulting from the constant discharge simulation (4461 

m3/s) upstream and the downstream rating curve was selected; Item: Surface elevation; 

 Boundary conditions: Boundary conditions: the .dfs0 file with the hydrograph of the 

daily-mean flows recorded at Bechet Gauge Station (upstream) during the simulation 

period; Type: Specified discharge, Format: Strong formulation, Varying in time; and 

downstream the .dfs0 file with the rating curve valid for 2017 at Corabia Gauge 

Station; Type: Specified level, Format: Rating Curve. 

 Output items (results obtained - Figure 33): Surface elevation, Total water depth, 

Current Speed, U velocity, V velocity.  

 
      Figure 32. Simulation Results 
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4.  RESULTS AND CONCLUSIONS 

 

The model simulates the unsteady flow taking into account density variations, 

bathymetry and external forcings. At the end of the simulation (of approximately 38 hours 

running time) there were calculated, for each mesh element and time step of the model: Surface 

elevation - Figure 34, Total water depth - Figure 35, Current speed - Figure 36 and Speed 

direction (components U and V - U velocity, V velocity) - Figure 37 and Figure 38. This 

information is stored in a .dfsu file format.  

Etymologically, the concept of "simulation" comes from the Latin simulatio, which 

represents the ability to reproduce, imitate or represent a phenomenon.   

 

 

Figure 33. Surface elevation 

 

 

Figure 34. Total water depth 

 

 

Figure 35. Current speed 
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Figure 36. U velocity 

 

Figure 37. V velocity 

The MIKE 21 HD output results can be used as input for other MIKE 21 modules, such 

as the Sediment Transport Module, the Advection-Dispersion module (AD), the Particle 

tracking (PA) and the Environment module (MIKE ECO Lab).  

After setting-up the model, in order to demonstrate the ability of the two-dimensional 

hydrodynamic model to accurately reproduce the behavior of any other similar hydrological 

event, the next step refers to model calibration and validation. 

 Calibration of the 2D hydrodynamic model  

The first step in the calibration process was to create a one-dimensional hydraulic model 

using the MIKE Hydro River module, based on 27 cross-sections extracted from the DTM 

available for the Bechet-Corabia critical sector and keeping the same input data as for the 2D 

model, including the common simulation period (23.04.2017 - 05.06.2017). 

The calibration of the one-dimensional model has been achieved gradually through 

adjustments of the Manning’s roughness coefficients along the river, in order to achieve a 

satisfactory difference between simulated values of water levels and measured values of water 

levels in the downstream section. 

The cross sections can be divided in main channel and overbank sections, with different 

roughness properties. Finally, the best results were obtained for values of the Manning 

roughness coefficient (M) which differ for the main channel, islands and floodplain. The values 

were included in the interval 10 - 38.46, as presented in Figure 22.  
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After running the 1D model with unsteady flow, using the previously adjusted M values, 

the hydrograph of the simulated daily-mean water levels was compared with the hydrograph of 

the measured daily-mean water levels at Corabia Gauge Station, the differences being included 

in the [-10.3 cm, +7.9 cm] interval, with a mean value of -1.6 cm (Figure 39).     

 

Figure 39. 1D Hydrodynamic Model calibration 

For the calibration of the 2D hydrodynamic model, the file obtained by adjusting the 

values of the roughness coefficients was used, following the tests performed by 1D modeling. 

The comparison between simulated and measured values of daily-mean water levels at Corabia 

Gauge Station is shown in Figure 40. The differences were included in the [-5.35 cm,  

+12.35cm] interval, with a mean value of +2.25 cm.  

 

Figura 40. 2D Hydrodynamic Model calibration 
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 Validation of the 2D hydrodynamic model  

Validation of the 2D hydraulic model has been performed by simulating the hydrograph 

of the daily-mean flows recorded at Bechet gauge station between 03.03.2017 to 31.03.2017. 

The daily-mean flows in this interval are higher than those recorded during the calibration 

period. The maximum flow value recorded in the validation period was 8010 m3/s, and the 

minimum was 6010 m3/s, while the maximum flow value recorded during the calibration period 

was 7270 m3/s and the minimum only 4300 m3/s. 

 

Figure 41. Daily-mean water level comparison at Corabia gauge station for the validation 

period (03.03.2017 - 31.03.2017) 

The differences between simulated and measured values of daily-mean water levels at 

Corabia gauge station were included in the [-3.44 cm, +8.76 cm] interval, with a mean value of 

+2.24 cm (Figure 41). 

 

 Conclusions 

Considering the obtained results, it can be concluded that the two-dimensional 

hydrodynamic model has been fully calibrated and validated. This model represents a very 

useful tool for understanding and predicting river behaviour. Furthermore, this is the starting 

point in obtaining a sediment transport model of the Bechet-Corabia critical sector, to support 

the selection of technical solutions that must be implemented.   
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